



Самостоятельная работа студентов
Предмет
«КОМПЬЮТЕРНАЯ ГРАФИКА»
СПЕЦИАЛИЗАЦИЯ  «ЖИВОПИСЬ»
ДНЕВНАЯ ФОРМА ОБУЧЕНИЯ
КУРС II (4 семест)













Перечень тем для самостоятельной работы

	№п./п.
	Темы для самостоятельной работы
	Количество часов

	1
	Тема 1. Вступительная беседа Векторная и растровая графика.
	3

	2
	Тема 2. Настройка рабочего пространства CorelDraw
	5

	3
	Тема 3. Панель инструментов.
	5

	4
	Тема 4. Создание и модификация объектов.
	3

	5
	Тема 5. Создание и редактирование контуров.
	5

	6
	Тема 6. Организация объектов.
	5

	7
	Тема 7. Текст.
	5

	8
	Тема 8. Заливка объектов и контуров.
	3

	9
	Тема 9. Комбинирование объектов.
	3

	10
	Тема 10. Спецэффекты.
	2

	11
	Тема 11. Экспорт растровых изображений. Печать. 
	3

	
	Всего часов:
	42



График для изучения тем самостоятельной работы

	№п./п.
	Темы для самостоятельной работы
	Количество часов
	Срок выполнения

	1
	Тема 1. Вступительная беседа Векторная и растровая графика.
	3
	январь

	2
	Тема 2. Настройка рабочего пространства CorelDraw
	5
	февраль

	3
	Тема 3. Панель инструментов.
	5
	февраль

	4
	Тема 4. Создание и модификация объектов.
	3
	март

	5
	Тема 5. Создание и редактирование контуров. Итоговое задание.
	5
	март

	6
	Тема 6. Организация объектов.
	5
	март

	7
	Тема 7. Текст.
Итоговое задание.
	5
	апрель

	8
	Тема 8. Заливка объектов и контуров.
	3
	апрель

	9
	Тема 9. Комбинирование объектов.
	3
	май

	10
	Тема 10. Спецэффекты.
	2
	май

	11
	Тема 11. Импорт растровых изображений. Печать. Итоговое занятие.
	3
	июнь

	
	Всего часов
	42
	



Цель  и задачи учебной дисциплины
Самостоятельная работа развивает в студенте творческую инициативу, активность и самостоятельность художественного и образного мышления, что особенно важно для будущих художников. От того как подготовлен к самостоятельной работе студент, во многом зависит успех обучения и формирования его как будущего специалиста.
Самостоятельная работа содействует выявлению познавательной и мыслительной активности студентов, стимулирует развитие творческих способностей, предоставляет уникальную возможность для самореализации отдельного студента как творческой мыслящей, всесторонне развитой личности, что является первоочередной задачей, прежде всего для студентов творческих вузов.
Самостоятельная работа дает положительные результаты только тогда, когда она является целенаправленной, систематической и планомерной. Для этого разработан  целый ряд заданий для самостоятельной работы по предмету, предусматривающий рекомендации для выполнения заданий, которые позволят студентам более качественно подготовиться к их выполнению.
Оценивание учебной деятельности студента является одним из самых главных моментов в учебном процессе. Полученные результаты самостоятельной работы анализируются, акцентируя внимания на достоинствах и недостатках выполненной работы.
Принцип сознательности и активности самостоятельного учебного труда очень важен в процессе профессионального становления специалиста, так как исключает механическую работу, ориентирует студентов на глубокое понимание и осмысление содержания задания, на свободное владение приобретенными знаниями. Таким образом, самостоятельная работа студентов – один из важных составляющих современного образовательного процесса. В контексте изучения дисциплины «Компьютерная графика», задания, выполненные самостоятельно, помогут студентам достичь высокого профессионального уровня и добиться успехов в выполнении итоговых и творческих работ. 
1.1. Целью преподавания учебной дисциплины «Компьютерная графика» является: получение студентами знаний и практических навыков работы в прикладных графических программах CorelDraw и Adobe Photoshop, а также применение этих знаний для создания художественного образа в процессе роботы от авторского эскиза до оригинал макета, что является последним этапом в формировании художника компьютерной графики, необходимого для специальной подготовки и будущей профессиональной деятельности.
1.2. Основными задачами изучения дисциплины «Компьютерная графика» является -освоение теоретичных основ создания цифровых изображений, освоение практических навыков роботы с определенным кругом прикладных графических программ, освоение базовых знаний промышленных технологий, связанных с визуализацией, формирование определенной технической культуры в художественной среде, развитие практических навыков анализа созданного проекта, выбора технологий, программных продуктов, способов, что обеспечат выполнение проекта в полном объеме.
1.3. Согласно требованиям образовательно-профессиональной программы студенты должны:
знать: 
· принципиальную разницу, взаимодействие и область применения двух типов компьютерной графики;
· состав растрового изображения;
· состав векторного изображения;
· типы цветовых моделей;
· интерфейсы, функциональные возможности и особенности прикладных графических программ;
· что такое выделение, маска, альфа-канал;
· режимы смешивания цветов;
· теоретические основы создания цифровых изображений;
· основы промышленных технологий, которые связаны с визуализацией изображений.
уметь: 
· анализировать задачи, которые требуют создания, художественной обработки или редактирования с помощью компьютера, принимать решения для выбора технологий и техники исполнения;
· пользоваться инструментами рисования векторных линий и примитивов;
· создать и редактировать графический документ;
· пользоваться инструментами выделения;
· пользоваться, создавать и изменять параметры кисти;
· реставрировать изображения при помощи инструментов восстановления;
· использовать векторные фигуры в растровом редакторе;
· работать с текстом в растровом редакторе Photoshop;
· выполнять задания при помощи компьютера, которые требуют создания или редактирования изображения в пределах специализации «Художественное оформление», «Скульптура»;
· самостоятельно оценивать программные продукты их особенности, которые связаны с направлением выбранной профессиональной деятельности.


Общие методические указания
Самостоятельная работа студентов – одна из важнейших форм обучения, содержание которой определяется учебной программой дисциплины с ориентацией на требования образовательно-квалификационной характеристики специалиста. Это чётко спланированная работа студентов, выполняемая при методическом руководстве преподавателя, но без его непосредственного участия. Такая работа предполагает ориентацию на активные методы овладения знаниями, выработку умений и навыков видеть смысл и цель работы, организовать собственное самообразование, способность по – новому подходить к решению поставленных задач.
Преподаватель знакомит студентов с темами, которые выносятся для самостоятельной работы и требованиями, которые ставятся перед ними при выполнении самостоятельной работы.
Перед началом изучения темы дисциплины необходимо подобрать рекомендованную литературу.
Материал необходимо изучать в последовательности, предлагаемой учебной программой. При изучении вопросов темы необходимо внимательно ознакомиться с методическими указаниями, прочитать материал и приступить к выполнению работы.
Выполнение самостоятельных заданий поможет студентам лучше усвоить теоретический материал, приобрести определенные знания. 
Работа над самостоятельным изучением материала должна быть выполнена в соответствии с графиком проведения тематического и модульного контроля.

Тематический план

	№
	Название темы
	Количество учебных часов

	
	
	всего
	лекций
	практических
	семинарских
	самостоятельных

	
	Тема 1. Вступительная беседа Векторная и растровая графика.
	4
	
	1
	
	3

	
	Тема 2. Настройка рабочего пространства CorelDraw
	7
	
	2
	
	5

	
	Тема 3. Панель инструментов.
	7
	
	2
	
	5

	
	Тема 4. Создание и модификация объектов.
	4
	
	1
	
	3

	
	Тема 5. Создание и редактирование контуров. Итоговое задание.
	9
	
	4
	
	5

	
	Тема 6. Организация объектов.
	7
	
	2
	
	5

	
	Тема 7. Текст.
	9
	
	4
	
	5

	
	Тема 8. Заливка объектов и контуров.
	4
	
	1
	
	3

	
	Тема 9. Комбинирование объектов.
	5
	
	2
	
	3

	
	Тема 10. Спецэффекты.
	3
	
	1
	
	2

	
	Тема 11. Импорт растровых изображений. Печать.
	4
	
	1
	
	3

	
	Всего часов
	63
	
	21
	
	42



План самостоятельного изучения
2 курс 4 семестр
Тема 1. Вступительная беседа. Векторная и растровая графика.
Все изображения, с которыми работают программы машинной графики, разделяются на два класса; пиксельные и векторные.
В терминологии машинной графики  пиксельным изображением принято называть массив пикселей — одинаковых по размеру и форме плоских геометрических фигур (чаще всего — квадратов или кругов), расположенных в узлах регулярной  сетки. 
Векторным изображением в компьютерной графике принято называть совокупность более сложных и разнообразных геометрических объектов. Номенклатура таких объектов может быть более или менее широкой, в нее включаются простейшие геометрические фигуры (круги, эллипсы, прямоугольники, многоугольники, отрезки прямых и дуги кривых линий). 

Тема 2. Обзор рабочего пространства CorelDraw. 
В левой части рабочего пространства расположен специфический для продуктов фирмы Corel элемент интерфейса — так называемый набор инструментов (toolbox). 
В расположенной под строкой меню стандартной панели инструментов (toolbar) расположены элементы управления, соответствующие наиболее часто выполняемым командам: открытию, сохранению и закрытию файлов иллюстраций, операциям с системным буфером обмена, режимам и масштабу просмотра иллюстраций.
Ниже стандартной панели инструментов по умолчанию располагается панель атрибутов (property bar).
Вдоль правой границы окна расположена экранная палитра цветов (color palette).  Она применяется для задания цвета заливки и обводки объектов иллюстрации.
У нижнего края окна CorelDRAW находится строка состояния (status bar). В ней в процессе работы выводятся сведения о выделенном объекте и много вспомогательной информации о режиме работы программы.
Основная часть рабочего пространства CorelDRAW отведена для размещения окон документов (drawing windows) CorelDRAW. После создания документа CorelDRAW, в таком окне видно только изображение печатной страницы, на которой будет размещаться иллюстрация. Границы страницы показаны в виде рамки с тенью, однако они не являются элементом изображения. Объекты, из которых будет далее строиться иллюстрация, должны располагаться в пределах этих границ. Остальное пространство окна иллюстрации имеет свое название - рабочий стол — и используется обычно как временное хранилище объектов.

Тема 3. Панель инструментов.
Набор инструментов (toolbox). Формально являясь просто одной из множества инструментальных панелей программы, фактически он предназначен выбора рабочего режима и поэтому используется чаще других. Выбор режима осуществляется щелчком мышью на одной из кнопок набора инструментов. С выбора инструментов начинаются практически все действия пользователя над объектами изображения.
Некоторые кнопки инструментов снабжены треугольником в нижнем правом углу. Это - указание, что на самом деле с кнопкой связан не один, а несколько инструментов. Чтобы увидеть их все, вместо быстрого щелчка левой кнопкой мыши ее следует нажать (отпустив только после паузы в одну-две секунды) — на экране раскроется панель конкретного инструмента. 
Панель атрибутов (property bar). Она представляет собой совокупность элементов управления, соответствующих управляющим параметрам выделенного объекта и стандартным операциям, которые можно выполнить над ним с помощью выбранного инструмента. Содержимое панели атрибутов постоянно меняется.
Тема 4. Создание и модификация объектов.
Основой работы с изображением в CorelDRAW являются объекты. Несколько упрощая, можно констатировать следующее: все графические объекты, с которыми приходится иметь дело пользователю этой программы, можно разбить на две категории — линии и примитивы.
Форма линий произвольна и не связана никакими ограничениями, кроме творческого замысла художника. Сказать «построим линию» означает не сказать почти ничего, и никаких четких зрительных образов за понятием «линия» не стоит. Однако если сказать, что четыре попарно равных отрезка прямых линий, соединяясь в конечных точках, образуют при этом четыре прямых угла, то в сознании всплывает не только четкий зрительный образ, но и термин для обозначения подобных объектов - «прямоугольник». Конечно, нельзя построить просто прямоугольник, без дополнительного уточнения не обойтись, но отличия прямоугольников от других графических объектов достаточно очевидны и позволяют выделить их в отдельный класс объектов. Чтобы выделить конкретный объект этого класса, достаточно задать значения его атрибутов, например высоту и ширину.
В CorelDRAW имеется несколько классов таких четко определяемых графических  объектов под обобщающим названием примитивы.
К  примитивам относятся - прямоугольники, эллипсы, многоугольники, звезды, спирали, сетки (стандартные фигуры, у которых есть свои атрибуты).

Тема 5. Создание и редактирование контуров.
Модель кривой.
В основе принятой в CorelDRAW модели линий лежат два понятия: узел и сегмент.
Узлом называется точка на плоскости изображения, фиксирующая положение одного из концов сегмента кривой. Сегментом называется часть кривой, соединяющая два смежных узла. Узлы и сегменты неразрывно связаны друг с другом.
Любая кривая в CorelDRAW состоит из узлов и сегментов, и все операции с кривыми на самом деле представляют собой операции именно с ними. Узел полностью определяет характер предшествующего ему сегмента, поэтому для незамкнутой линии важно знать, который из двух ее крайних узлов является начальным, а для замкнутой — направление линии (по часовой стрелке или против нее). По характеру предшествующих сегментов выделяют три типа узлов: начальный узел незамкнутой кривой, а также прямолинейный (line) и криволинейный (curve) узлы.
Для узлов, смежных хотя бы с одним криволинейным сегментом, имеется еще одна классификация типов: они подразделяются на точки излома (cusp) и сглаженные узлы (smooth). 
Узел называется точкой излома в том случае, когда касательные, проведенные в узле к двум прилегающим к нему сегментам, не лежат на одной прямой, образуя угол, отличный от развернутого. 
Узел называется сглаженным, если касательные, проведенные к двум прилегающим к нему сегментам, лежат на одной прямой.
Создаются линии (кривые) при помощи инструментов: Freehand (Свободная форма), Polyline (Ломаная линия, 3-Point Curve (Кривая через 3 точки, Bézier (Кривая Безье), Pen (Перо), Artistic media (Художественное оформление).

Тема 6. Организация объектов.
Выравнивание объектов.
Выравниванием называется размещение всех выделенных объектов таким образом, чтобы их определенные точки (например, середины рамки выделения) располагались на одной прямой.
В CorelDRAW предусмотрен мощный инструмент, автоматизирующий выстраивание объектов в ряд вдоль прямой, положение которой задается одним из выравниваемых объектов или страницей документа.
Команда Arrange > Align and Distribute (Монтаж > Выровнять и распределить) и кнопка Align (Выровнять) панели атрибутов раскрывают на экране диалоговое окно, с помощью первой вкладки которого можно автоматически выровнять середины или края рамок выделения выделенных объектов по горизонтали и/или вертикали.
Распределение объектов.
Распределением объектов в CorelDRAW называется размещение объектов, при котором соблюдается равенство расстояний между маркерами их рамок выделения. Добиться этого размещением объектов вручную практически невозможно. Значительно удобнее решать такую задачу с помощью вкладки Distribute (Распределить) диалогового окна Align and Distribute (Выровнять и распределить).
Равномерность при распределении объектов может достигаться двумя принципиально различными способами: равными могут быть расстояния между одноименными маркерами рамок выделения  или интервалы, разделяющие объекты. При размещении объектов с разными габаритными размерами результаты размещения этими двумя способами могут сильно различаться. 

Тема 7. Инструмент «Текст».
Необходимость введения в инструментарий художника-оформителя, дизайнера, художника по рекламе средств автоматизации работы с текстом не вызывает сомнений. Более того, эволюция программ для работы с графическими изображениями привела к тому, что встроенные в них средства для работы с текстовой информацией по своим возможностям вплотную приблизились к аналогичным средствам не только текстовых процессоров, но и более развитых в этом аспекте редакционно-издательских систем. 
CorelDRAW имеется не один, а два класса текстовых объектов, во многом схожих, но в то же время четко различимых - как по своей структуре, так и по поведению. 
Фигурный текст
В общем случае фигурный текст представляет собой многоуровневый соединенный объект. Если такой объект выделить, а затем выбрать команду Arrange > Break Apart (Монтаж > Разъединить), после первого разъединения он превращается в совокупность фигурных текстов, каждый из которых соответствует строке исходного фигурного текста. Разъединение строки дает совокупность слов, и только разъединение слова дает совокупность фигурных текстов, каждый из которых будет «элементарным» — разъединить его не удастся, поскольку он состоит из одной младшей структурной единицы текста, символа.
Чтобы начать ввод блока фигурного текста, достаточно щелкнуть мышью в той точке страницы, где должен разместиться текст. При необходимости перехода на новую строку следует нажать клавишу Enter.
Простой текст
Так же как фигурный, простой текст представляет собой многоуровневый соединенный объект, но уровней, которые простой текст проходит при разъединении, больше, чем у фигурного текста. При разъединении большого объема простого текста могут получаться следующие структурные единицы: колонки текста, пункты перечисления, абзацы, строки, слова, символы. Кроме того, в отличие от фигурного текста простой текст не может располагаться непосредственно на печатной странице. В CorelDRAW любой простой текст располагается внутри особого объекта — рамки простом текста (paragraph text frame). При помощи связен рамки могут образовать составной объект — цепочку рамок простого текста, отдельные элементы которой могут размещаться даже на различных страницах документа CorelDRAW. Базовая форма рамки простого текста — прямоугольник, но в процессе последующих преобразований эти прямоугольники могут принимать произвольные формы
Простой текст создается при помощи того же инструмента, что фигурный, а именно — инструмента Text (Текст). Правда, создание простого текста предполагает еще одно предварительное действие — создание рамки простого текста. Поэтому после выбора инструмента Text (Текст) в наборе инструментов следует переместить указатель мыши в точку, где предполагается разместить один из углов будущей рамки, и перетащить его по ее диагонали. После отпускания кнопки мыши па экране появится изображение рамки выбранных габаритов, внутри которой расположится текстовый курсор в виде вертикальной черты. Можно приступать к вводу текста с клавиатуры.
При вводе простого текста поведение CorelDRAW иное, чем при вводе фигурного текста. Во-первых, переход на новую строку определяется уже не пользователем, а автоматически, по мере достижения текстом правой границы рамки, причем нажатие клавиши Enter означает переход не к следующей строке, а к следующему абзацу, который является более крупной структурной единицей текста, чем строка. Во-вторых, когда вводимый текст достигнет нижней границы рамки, текстовый курсор пропадает и вновь вводимого текста больше не видно. Из этого не следует, что текст не вводится — он лишь не отображается в пределах рамки.
Создание цепочки связанных рамок.
Цепочками связанных рамок простого текста пользуются для того, чтобы разместить одни текстовый фрагмент в нескольких местах одной страницы или на разных страницах документа. Речь идет не о размещении копий, а о продолжении текста при переходе из одной рамки в другую.

Тема 8. Заливка объектов и контуров.
Однородные заливки.
Однородной заливкой называется заполнение ограниченного замкнутой кривой объекта цветом, который не меняется в пределах объекта. Чтобы назначить выделенному объекту или нескольким объектам однородную заливку с помощью палитры, достаточно щелкнуть на образце нужного цвета мышью. 
Специальные заливки.
Программа CorelDRAW изначально предназначалась для работы с иллюстративной графикой. В природе и окружающей человека среде практически не встречаются объекты с идеально однородными цветовыми поверхностями, и попытки разбить их изображения на однородно закрашенные части приводит к неестественности, «мультяшности». 
Градиентные и сетчатые заливки.
В категорию градиентных и сетчатых заливок сведены два класса заливок, обладающих общим признаком: в пределах заливаемого объекта выделяются некие «опорные пункты», для которых фиксируется цвет заливки, а в промежутках между ними цвет «перетекает», плавно меняясь. В полиграфии такие заливки называют цветовыми растяжками. В градиентных заливках в роли «опорных пунктов» выступают точки, прямые, квадраты и окружности, расположенные четко определенным образом (зависящим от типа градиентной заливки).
Сетчатые заливки.
Чтобы построить аналогичную сетчатой заливку другими средствами, потребовалось бы создавать множество отдельных объектов и градиентных заливок, а потом долго и кропотливо подгонять их друг к другу, добиваясь эффекта, с применением сетчатой заливки возникающего автоматически.
При назначении сетчатой заливки объекту произвольной формы на него накладывается сетка, имеющая заранее заданное число «строк» и «столбцов». Сетка состоит из узлов, соединенных линиями. 
Тема 9. Комбинирование объектов.
Операции группировки и соединения обратимы, и полученные в результате них образования можно снова превратить в отдельные объекты. Кроме того, в CorelDRAW есть группа необратимых операций, которые связывают исходные объекты сильнее, превращая их в единый объект: объединение, пересечение и исключение. Полученные в результате этих операций объекты уже нельзя преобразовать в исходные.
Группирование и разгруппирование.
Группированием называется операция, соединяющая совокупность отдельных объектов или ранее созданных групп в группу. Связывание объектов в группу позволяет обращаться с ними как с единым целым, выполняя преобразования группы как преобразование единого объекта.
Соединение и разъединение
Кнопка Combine (Соединить), предназначенная для выполнения этой команды, становится доступной на панели атрибутов после выделения не менее чем двух отдельных объектов. Побочным эффектом действия команды соединения является преобразование всех выделенных объектов в совокупности кривых (которые и становятся ветвями соединенной линии).
Для разъединения соединенной кривой на составляющие ее ветви используется кнопка Break Apart (Разъединить) панели атрибутов. После разъединения каждая ветвь приобретает статус отдельного объекта.
Объединение.
Операция объединения представляет собой удаление пересекающихся частей объединяемых объектов и составление из фрагментов их границ новой границы по линии общего абриса. Участвовать в операции могут два одиночных объекта, одиночный объект и совокупность объектов или две совокупности объектов.
Пересечение.
Операция пересечения создает новый объект из области пересечения двух или более объектов, участвующих в операции. Новый объект наследует атрибуты заливки и обводки «родительского» объекта.
Исключение.
Исключением объектов называется операция, при которой у указанного объекта удаляются части, перекрываемые выделенным объектом. 
Как обычно, в совокупностях и выделенных, и указанных объектов может быть несколько объектов. Если перед выполнением исключения выделено несколько объектов, то «форма для высечки» составляется как результат объединения этих объектов.
В состав совокупности указанных объектов могут входить не только индивидуальные объекты, но и их группы.

Тема 10. Спецэффекты.
Основное назначение CorelDRAW — создание иллюстративной графики, большинство произведений которой носят плоскостной, подчеркнуто графический характер. Поэтому передавать глубину и объем изображаемой сцены с учетом освещения и направления взгляда приходится чисто графическими приемами, имитируя блики и тени дополнительными объектами, а перспективу — искажением контурных линий объектов.
В CorelDRAW имеются средства для автоматического построения эффектов, имитирующих объемность и глубину сцены. В первую очередь к ним относится преобразование перспективы.
Для построения теней, отбрасываемых предметами на плоскость, можно воспользоваться приемом объединения группы объектов, изображающих фигуру, с последующим изменением заливки и формы полученного объекта, но можно воспользоваться и специальным инструментом для построения падающих теней.
Эффект экструзии позволяет построить на рисунке проекцию обобщенного цилиндра - тела, образующегося при перемещении плоской фигуры в пространстве в направлении, перпендикулярном ее плоскости. CorelDRAW автоматически выполняет параллельное или перспективное проецирование фигуры и строит как изображения боковых поверхностен обобщенного цилиндра, так и светотеневую картину на них.
Пошаговый переход позволяет быстро построить последовательность переходных форм между двумя управляющими объектами, разместить их вдоль заданной траектории, а затем менять внешний вид всех объектов одновременно, редактируя управляющие объекты перехода.
Контуры подобия, представляют собой вариант пошагового перехода с одним управляющим объектом. Семейство подчиненных объектов контура строится как последовательность фигур, близких геометрически к управляющему объекту.
Изобразительные возможности клонов, пошаговых переходов и ореолов практически безграничны, и сообщество художников, работающих с CorelDRAW, постоянно изобретает новые способы их применения.



Тема 11.Экспорт растровых изображений. Печать.
Всего лишь несколько лет назад в 99 случаях из 100 процесс работы над графическим проектом завершался, выводом построенных с помощью CorelDRAW изображений на печать или передачей файлов в бюро полиграфического обслуживания. Неудивительно, что от версии к версии средства CorelDRAW, обеспечивающие подготовку к выводу на печать и саму эту процедуру, постоянно совершенствовались. Сегодня все больше графических работ публикуется в Интернете, и он уже перехватил у полиграфической промышленности пальму первенства в этой области. Отмечайся бурный рост и других технологий электронной. Поэтому сегодня результаты труда компьютерного художника материализуются в одном из трех вариантов: 
- в виде отпечатков, выполненных на монохромных или цветных принтерах, установленных в художественной студии или офисе, где работает художник; 
- в виде файлов с изображениями в различных форматах, предназначеных для интеграции в состав web-страниц, публикации другими электронными средствами или размещения на ftp-серверах в первом случаев качестве дополнения к графическому изображению может разрабатываться так называемая карта - описание активных участков изображения, используемых в качестве ссылок;
- в виде файлов с векторными и точечными изображениями в формате PostScript предназначенных для передачи в бюро полиграфического обслуживания в котором эти файлы выводятся на пленку специальными устройствами.
Экспорт рисунка в файл.
По умолчанию при сохранении рисунка с помощью команды File > Save As (Файл > Сохранить как) создается файл векторного формата CDR — собственного формата программы CorelDRAW. Экспорт рисунка в другой векторный формат можно выполнить с помощью стандартного диалогового окна Save As (Сохранить как), выбрав соответствующую желаемому формату альтернативу в списке Files of type (Тип файла). Однако более универсальным способом экспорта оказывается команда File > Export (Файл > Экспорт), дающая возможность сохранять проект как в векторных, так и в точечных форматах.
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КРИТЕРИИ ОЦЕНИВАНИЯ УРОВНЯ ПРЕОБРЕТЕННЫХ ЗНАНИЙ, УМЕНИЙ, НАВЫКОВ СТУДЕНТОВ
	Уровни знаний
	Требования к знаниям, умениям и навыкам студентов

	
Высокий
5 (отлично)

	Студент владеет глубокими знаниями по предмету, интересуется компьютерной графикой. Творчески подходит к каждому заданию, обладает приемами и инструментами компьютерной графики, работает самостоятельно, интересуется предметом и новыми возможностями графических редакторов. Студент  проявляет  полные  и  глубокие  знания  теории,  демонстрируя  отличные  практические  навыки,  находчивость  и  готовность  к  выполнению  профессиональных  задач Работы студента могут быть использованы в методических целях и на выставках.


	
Достаточный
4 (хорошо)
	установленный  срок.  
Работа  исполнена  качественно,  на  хорошем  идейно-художественном  уровне,  творчески.
Композиционное  построение  изображения завершено,  соответствует  основным  требованиям.  
Студент  проявляет  достаточные  знания  по  курсу  дисциплины,  демонстрируя готовность Задание  выполнено  в  полном  объёме  и  в  
к выполнению  практических  задач.

	
	

	
Средний
3(удовлетворительно)

	Объём  работы  -  удовлетворительный.
Раскрытие  темы  и  качество  исполнения  - на  среднем  идейно-художественном  уровне.  
Композиционное  построение  изображения  удовлетворяет  минимальным  требованиям.  
Студент  выявляет  теоретические  знания  учебного  материала,  на  уровне  репродуктивного  воспроизведения,  демонстрируя  при  этом  навыки  в  решении  основных  профессиональных  задач. 

	
	

	
Начальный
2(неудовлетворительно)

	Объём  работы  -  неудовлетворительный.
Тема  не  раскрыта.  Качество  исполнения  - на   низком  уровне.  
Композиционное  построение  изображения  не  удовлетворяет  минимум  требований.  
В  работе  студент  выявляет  поверхностные  знания  теории,  отсутствие  навыков  освоения  художественных  техник  и  материалов.  
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